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SPRACHE IN Paragraph-Style “05 - STANDARD Fließtext” passend einstellen

1	 GUITAR RIG 4 の世界へようこそ!
GUITAR RIG KONTROL EDITION はギターとベースプレーヤー用の完全なソリューションです。 ステー
ジで即使用することが可能な付属の RIG-KONTROL I/O フットペダルを用いて、 内蔵オーディオインタ
ーフェイスによる GUITAR RIG 4 のスタジオ品質のサウンドを操ることが可能です。 当然GUITAR RIG 4 
での使用に最適な設計が施されていますが、 仕様規格及び MIDI サポートは殆どのプロ用オーディオソフ
トウェアに対応しています。
RIG KONTROL は電源付高速 USB 2.0 を介して使用しているコンピュータへと接続します。 これには2
つのインプットがあり、各楽器またはラインレベルシグナルに対応します。 2チャンネルのラインアウト端子で
モニターシステムにシグナルを送信、1つのステレオジャックはヘッドフォンでのモニタリングに対応します。
コントローラーとして RIG KONTROL には9つのスイッチとペダルがあり、GUITAR RIG 4 の機能全般を
コントロールします。 更にMIDI と2つのアナログインプットで外部コントローラーへと接続します。
以下の章では RIG KONTROL の各機能と最適な使用方法について解説しています。 この製品に慣れ親し
んで頂く為に、このマニュアルを熟読することをお勧めします。
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2	 ご使用の前に – 注意事項
GUITAR RIG 4 を使用する前にこの章を詳しく読み、内容を把握してください。

2.1	 シリアルナンバー& ネームプレート
GUITAR RIG KONTROL EDITION には 2 つのシリアルナンバーが存在します。 RIG KONTROL のシリ
アルナンバーは、製品モデル名称と使用情報等と同様に、ハードウェアの底部に表示されています。 GUITAR 
RIG 4 を製品起動する為のシリアルナンバーは製品 CD のスリーブに記載されています。

2.2	 安全に使用するために
以下の項目を熟読し、本製品の破損、故障等の原因となる要因を避けてください。

2.2.1	 注意事項
聴覚障害とならないように、以下の各注意事項に従ってください。
•• 本製品をアンプ、ヘッドフォン、スピーカー、等と共に使用することで、聴覚に障害をもたらす音量を生成

することがあります。
•• 過度な音量再生を防ぐ為に、RIG KONTROL を使用する際には全ボリュームをまず最小値に絞ってか

ら使用をはじめることを強く推奨します。 その後、音量を最適な音量に設定してください。
•• ボリュームを大音量の設定にしたまま長期にわたって使用しないでください。聴力低下や耳鳴りの症状

が現れた場合には、すぐに医師の診察を受けてください。

2.2.2	 危険事項
接続したRIG KONTROL またはその他の機器の、使用中または調整中の故障及び破損を避けるために以下
の注意事項を必ず確認してください。
•• 機器を開けて分解や内蔵部品を改造しないで下さい。この機器には個人で修復できる部品はありませ

ん。機器に故障等の問題が見られる場合は直ちに使用をやめ、専門の業者にご相談ください。
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•• 機器を雨天で使用せず、及び水のある場所、湿気の多い場所での使用はしないでください。
•• 機材の破損につながる物や液体をハードウェアに置いたりかけたりしないでください。
•• 異常高温状況下での使用、保管(例、車内での直射日光に機器をさらす、または暖房器具に近接した状

況下での保管)、または振動の多い場所での使用、保管を避けてください 
•• RIG KONTROL を落下する可能性のある場所で使用しないで下さい。 本製品を移動する際には、接

続しているケーブル類を全てはずして移動してください。
•• 各機器の電源のスイッチ入切の際には、必ず全ての音量ボリュームを最小値にしてください 
•• ノブ、コネクター部に過度の力をかけて使用しないでください。
•• RIG KONTROL を清掃する際は、乾燥した柔らかい布を使用してください。 シンナーや、ベンジン、洗

剤当の薬液、又は薬液のしみこんだ清掃用布は使用しないでください。

2.2.3	 廃棄処分時の注意点
製品が修理不可能な状態になった場合、または製品を主文する場合は、お住まいの国が取り決めた法律に
従って、電化製品の正規廃棄手順を取り廃棄してください。

2.3	 免責事項
Native Instruments GmbH はRIG KONTROL の改造、または間違った使用法によるデータ及び機器の
各故障、紛失、破損に対し一切の責任を負いません。
これらの情報はこのマニュアルが印刷またはデジタル資料として出版されるまでの最新版です。しかしながら
Native Instrumentsはこの製品に関するアップデートの権限を有し、製品の内容と本仕様書は予告なしに
変更される場合があります。
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3	 RIG KONTROL ハードウェア
このセクションではRIG KONTROL ハードウェアの概要を紹介します。

3.1	 トップパネル

1	 各フットスイッチはソフトウェア上でプリセット内容の設定、各コンポーネントのオンオフ切り替え等の
各機能をアサイン可能です。 各スイッチには起動状態を示す LED が備わっています。 最上段には 
GUITAR RIG 4 で頻繁に使用する機能がデフォルトアサインされています。

2	 ソフトウェア上で連続的に変化するパラメーター(ボリューム、ワウワウ等)は、エクスプレッションペダル
でコントロールします。 ペダルの下には自由にアサイン可能なスイッチが搭載されています。

3	 現在選択しているGUITAR RIG 4 のプリセット番号を表示します。
4	 このLEDメーターでオーディオシグナルの入力値を表示します。 赤色 LED はクリッピングが生じたと

きに点灯します。 クリッピングが生じる場合は、関係するインプットゲインを下げてください。
5	 この LED メーターでオーディオシグナルの出力値を表示します。 赤色 LED はクリッピングが生じた

ときに点灯します。 クリッピングが生じる場合は、関係するアウトプットレベルを下げてください。
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6	 この LED は RIG KONTROL が MIDI 信号をシーケンサー、または他のコントローラーから受信した
場合に反応します。

7	 この LED はペダルの下にあるスイッチが起動している場合に点灯します。

3.2	 リア・パネル

1	 Inst/Line スイッチでインプット 1 と 2 の入力感度を切り替えます。 スイッチを解除した状態で、イン
プットはギターやベース等の楽器に対応し、押した状態でライン入力に対応します。 選択したインプッ
トタイプは機器のトップパネルでも表示します。

2	 このノブでインプット 1 のゲインをコントロールします。
3	 インプット1 用ソケットで、(¼” ジャック、TRS バランスド) Line/Inst スイッチの設定により、各ライン

入力シグナル、及び楽器レベルシグナルに対応します。 ギター、ベース、キーボード、またはステレオ機
器の左チャンネルをここに接続します。

4	 インプット2 用ソケットで、(¼” ジャック、TRS バランスド) Line/Inst スイッチの設定により、各ライン入
力シグナル、及び楽器レベルシグナルに対応します。 2番目のギター、ベース、キーボード、またはステレ
オ機器の右チャンネルをここに接続します。

5	 このノブでインプット 2 のゲインをコントロールします。
6	 これらの端子からオーディオインターフェイスの音声を出力します。 ステレオ音声を使用するには両方

を使用してください。
7	 アウトプット増幅値は最大または –14dB に調節可能です。
8	 これとは別にヘッドフォンアウトプットボリュームも調節可能です。
9	 ステレオヘッドフォン端子です。
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10	 外部エクスプレッションペダル、フットスイッチ、ボリュームペダル、またはスイッチボックス用端子です。
11	 RIG KONTROL には MIDI インターフェイス(MIDI In /Out)が備わっています。 RIG KONTROL か

ら GUITAR RIG 4 にコントロールメッセージを送信する MIDI は必要ありませんが、この機能により 
MIDI シグナルを他のアプリケーションに送信することが可能となります。

12	 USB ポートを使用して使用しているコンピューターに接続します。 GUITAR RIG KONTROL を使用
するには使用しているコンピューターがUSB 2.0 に対応している必要があります。 本機器はUSB バ
スパワーを使用しています。 本機器を使用しているコンピューターのUSB 2.0 に直接接続し、パワー
ド対応していないUSB ハブの使用はしないで下さい。 USB ケーブルはUSB フック等で常に保護され
た状態で使用してください。
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4	 Windows XP/Windows Vistaへのインス
トール

この章ではオーディオインターフェイスの設定の観点から、Windows XP と Windows Vista  に RIG 
KONTROL ハードウェアをインストールする方法について解説します。  コントローラーとしてフットペダル
を GUITAR RIG 4 で起動する方法、関連したMIDI 機能の使用方法に関しては、本マニュアルのセクショ
ン6 を参照してください。
GUITAR RIG 4 ソフトウェアに関する詳細は、GUITAR RIG 4 マニュアルを参照してください。 マニュアル
は製品 CD、またはGUITAR RIG 4 メニューの Help > Open Manual > Japanese から閲覧可能です。

4.1	 ソフトウェアインストール
管理者権を使用してログインしてください。 この時点では、まだ RIG KONTROL を接続しないでください。
1.	 製品CD をブラウズし、セットアップファイルを探してください。ファイル名称は、Guitar Rig 4 Setup

です。ダウンロードしたバージョンのGuitar Rig 4 を使用している場合は、セットアップファイルを最初
に解凍する必要があります。

2.	 “Guitar Rig 4 Setup”をダブルクリックしてインストールを開始します。
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3.	 スクリーン表示の手順に従ってインストールを行ってください。
4.	 DAW (Digital Audio Workstation 、デジタルワークステーション、例、使用しているシーケンスソフ

トウェア)環境のプラグインフォルダーのパスを指定するように促されます。 GUITAR RIG 4 をスタン
ドアローンモードで使用する場合、またはプラグインが何かわからない場合は、通常設定を行います。

5.	 GUITAR RIG オーディオインターフェイス用ドライバのインストールを行う内容の質問が表示されます。 
“RIG KONTROL” を選択し、“Continue” をクリックしてください。

6.	 インストール中、Windows セキュリティーメッセージが表示される場合があります(例、“このドライバは
Windows ロゴテストに合格していません”または“Windows はこのドライバソフトウェアの発行元を検
証できません”等)。このメッセージを気にする必要はありません。 “続行する” (Windows XP)をクリッ
ク、または“このドライバソフトウェアをインストール” (Windows Vista) をクリックし、インストールを
続行してください。
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7.	 手順が完了したらコンピューターを再起動してください。

すると、以下のアプリケーションがハードドライブ上に設置されます。
•• GUITAR RIG 4 – 全機能を装備したスタンドアローンアプリケーションです。
•• GUITAR RIG 4 プラグイン – GUITAR RIG 4  を使用しているデジタルワークステーション(DAW)上

でプラグインとして使用可能です。 WINDOWS ではGUITAR RIG 4 は VST または RTAS® プラグ
イン形式で作動します。

•• Native Instruments Service Center – このアプリケーションで製品の起動とアップデートを管理し
ます。詳細についてはセットアップガイドを参照してください。

•• RIG KONTROL のドライバです。

ハードウェアドライバのみをインストールする場合は、インストールCD のドライバ専用インストールファイル
を使用してください。このファイルの最新バージョンはNative Instruments ウェッブサイトのサポートセク
ションから取得可能です。
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4.2	 ハードウェア インストール
付属のUSB ケーブルを使用し、RIG KONTROL を使用しているコンピューターのUSB 2.0 ポートに接続
してください。

RIG KONTROL の電源供給源は USB です。 この機器を正常に作動するには単体のUSB 2.0 コントロ
ーラー、または電源を供給するUSB 2.0 ハブの使用が必須です。 Windows XP ではRIG KONTROL が
正常に機能するために Service Pack 2 以上の環境が必要です。Windows のバージョンを確認するには”
システムのプロパティ”をご覧ください。
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ドライバが正常にインストールされると、 RIG KONTROL が自動検知されます。 認識されない場合は、ソ
フトウェアのインストールを上記で説明したようにもう一度行ってください。
ここまでの作業でいくつかのドライバモジュールが RIG KONTROL に割り当てられ、それぞれの新規機器
をどのようににインストールするか指定するためのポップアップウインドウが表示されます。
1.	 “Windows Update Web site”には接続しない選択をしてください。
2.	  “Install the software automatically 、ソフトウェアの自動インストール” (Windows XP)また

は“Locate and install driver software 、ドライバソフトウェアを指定し、インストールする” (Windows 
Vista).を選択してください。
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3.	 スクリーンに表示される指示に従ってください。
4.	 Windows セキュリティー警告画面が表示されます。 これらのメッセージの内容にはここでの設定の際

には重要性が無いので、“続行する” (Windows XP)または“このドライバソフトウェアをインストールす
る”をクリックし(Windows Vista)、ドライバのインストールを続けてください。

Windows コンピュータでは、ドライバが特定のUSB ポートを使用する場合があります。 USB ケーブルを
インストールしたポートとは異なるポートに接続した場合、ドライバ設定をもう一度行う必要がある場合があ
ります。 この場合は、上記の設定を再度行ってください
この時点でコンピュータが RIG KONTROL  を認識しない場合は、USB ケーブルをはずし、何秒か待った
後再接続してください。 それでも問題が解決しない場合は、インターフェイスを接続したままコンピュータを
再起動してください。
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4.3	 設定
この章ではGUITAR RIG 4 用に RIG KONTROL オーディオインターフェイスを Windows XP / Windows 
Vista  上で使用する方法を解説します。ここではサービスセンターを介して GUITAR RIG 4 の製品起動を
行ったものとします。製品起動に関してはセットアップガイドを参照してください。

4.3.1	 GUITAR RIG 4 の設定
それではGUITAR RIG 4 を設定し、RIG KONTROL オーディオインターフェイスを使用できる環境にしま
しょう。 この設定を行う前に、ソフトウェアを起動しておいてください。
ソフトウェアを始めて起動する場合は、以下の設定を行うためのオーディオセットアップウインドウが自動的
に表示されます。後でこの設定画面にアクセスするには、プログラムのメニューから File > Audio and MIDI 
Settings  と進んでください 

	

1.	 “Audio”タブで"ドライバ"インターフェイスとしてASIOを選択してください。
2.	 “Device”ドロップダウンメニューから、 RIG KONTROL を選択してください。
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GUITAR RIG KONTROL がリストに表示されない場合は、何か問題があります。 セクション 4.1 で解説
したように、インストールをもう一度行ってください。
“ASIO Config” をクリックしてドライバコントロールパネルにアクセス可能です。 ドライバコントロールパネ
ル(Driver Control Panel) の下部では、 RIG KONTROL ハードウェアの接続と、使用可能な状況かを表
示する2 つのフィールドを備えています。

	

オーディオインターフェイスでは以下のパラメーターの設定が可能です。
•• Presets: 標準的なタイプのプリセットを装備しており、強力なCPU処理能力を備えた高速システム用

の最小レイテンシーから、遅いシステム用の高いレイテンシー設定の選択が可能です。オーディオドライ
バの設定に精通しており、カスタム設定を行う場合は、User Defined Settings (次項を参照)を選択し
てください。

•• USB バッファサイズ(Buffersize)とAudio バッファサイズ: これらのパラメータは灰色表示で、プリセッ
トメニューから User Defined Settings を選択するとこの表示が切り替わります。 この設定でシス
テムのレイテンシー値を決定します。例)オーディオシグナルが RIG KONTROL ハードウェアを介して
使用しているヘッドフォン、またはスピーカーまでに到達する速度。 オーディオバッファサイズ(Audio 
Buffersize )の値は最低でもUSB バッファサイズの値の2倍の大きさに設定する必要があります。  USB 
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バッファサイズパラメーターがシステムのCPU 消費量に直接影響を与えます。   CPU使用量は使用し
ているコンピューターの性能によって異なりますので、各USB設定を試して最適な設定を見つけてくだ
さい。

•• サンプルレート(Sample Rate): 使用している音楽アプリケーションに対応したサンプル・レートを選択
してください。デフォルトでサンプルレートは44100 Hz (CD の音声品質と同等)に設定してあります。
高いサンプルレートで音質は向上しますが、CPU ロードも高くなります。

まずはレイテンシーのいずれかを選択してから、以下のインストールを続行することを推奨します。インス
トールが完了してから、再度“Audio and MIDI Settings”でシステムに最適なレイテンシーを設定してく
ださい。minimal latency を選択した場合オーディオドロップアウトがある場合は、low latency または 
standard latency 設定のどれかを試してください。高いレイテンシーを設定するほど、オーディオドロップ
アウトが生じる確率が低くなります。

4.3.2	 RIG KONTROL をデフォルトオーディオインターフェイスとして使用する
使用しているコンピュータの全ての音声再生用に RIG KONTROL を使用するには、本機器をデフォルトオ
ーディオインターフェイスとして設定する必要があります。
Windows XPでの設定方法は以下となっています。
1.	 Start > Control Panel > Sounds and Audio Devices と進みます。
2.	 「オーディオ」タブを選択します
3.	 「音の再生」と「録音」セクションで、 Default Device メニューをクリックし RIG KONTROL を選

択します。
4.	 「OK」をクリックして「サウンドとオーディオデバイス（Sounds and Audio Devices）」のダイアログ

を閉じます。
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Windows Vistaでの設定方法は以下となっています。
1.	 Start > Control Panel > Hardware and Sound > Sound と進みます
2.	 「再生」タブを選択します
3.	 機器リストから、RIG KONTROL を選択し、「規定値に設定（Set Default）」をクリックします
4.	 「録音」タブを選択します
5.	 機器リストから、RIG KONTROL を選択し、「規定値に設定（Set Default）」をクリックします
6.	 OKをクリックしてダイアログを閉じてください。
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4.4	 オーディオ接続とレベル
以下の章では、 RIG KONTROL にギターとモニターシステムを接続する方法を解説しており、またハードウ
ェア、ソフトウェア各での適切な音量設定についても解説しています。
この設定を行う前に、GUITAR RIG 4 を起動しておいてください。

4.4.1	 楽器の接続とインプットレベルの調整
1.	 モニターシステムのボリュームを最小にしてください。
2.	 プリアンプ等を使用して音声をブーストしている場合を除いて、インプットセレクターは“Instrument”  

(ボタンを押していない状態) としてください。
3.	 ギター、またはベースからのケーブルを RIG KONTROL のインプットジャックソケットに差し込んでく

ださい。
4.	 インプットを使用しない場合、ボリュームを最小に絞っておきてください。

ステレオ音声を出力する機材(シンセサイザー等)を接続する場合は、各ステレオチャンネルに接続してくださ
い。

インターフェイスを使用して十分な音量を維持しつつ音質を最適な状態に設定するには、 RIG KONTROL 
のインプットレベルを注意深く設定する必要があります。
インプットレベルメーター を確認しながら、最適なインプットレベルに調節してくださ
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メーター表示内容 意味

全 LED がオフの状態 入力シグナルが無い状態です。

LED が緑に点滅する状態 シグナルを入力しています。

LED が緑と赤に点滅する状態 入力シグナルが大きすぎます。

インプット感度を調節する前に、ギターのボリュームノブを上げてください。 通常演奏する音量でコードを
弾き、インプットレベルメーターを確認してください。
1.	 演奏しながらLEDが赤表示するまで、選択したインプットジャックの隣にあるインプットレベルノブを上

げてください。
2.	 その後赤色点灯しなくなるまでノブを微妙に下げていきます。思い切りコードを弾いてもLEDが赤色点

灯しない位置まで慎重に調節してください。

これでインプット感度が最適な状態に設定となり、RIG KONTROL でクリッピングなく最大限のダイナミッ
クレンジ内で演奏することが可能です。

4.4.2	 2番目の楽器の接続
楽器同士の音量が殆ど同じ場合は、各インプットに異なる楽器を接続することも可能です。2番目の楽器をも
う一つのインプット端子に接続し、上記のようにインプットレベルを調節してください。
ステレオシグナルを生成する楽器を使用する場合は、両方のインプット端子をその楽器に使用することでス
テレオ音声を発生します。

% 単一のチャンネルのみを使用する場合は、一方のチャンネルゲイン(Gain )ノブをゼロにします。
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4.4.3	 GUITAR RIG 4 のインプットレベル
ここではギターを RIG KONTROL に接続しており、 インプットレベルが適切に設定されている前提で(セ
クション4.4.1を参照)解説します。 ここからはソフトウェア上でインプットシグナルを最適に設定します。
GUITAR RIG 4 ウインドウのヘッダ部分を確認してください。 そこにはチャンネルセレクター付きインプッ
トモジュール(L/R)、ノイズゲート、 リミッター付アウトプットモジュール、CPU 確認機能が備わっています。

インプットメーター(Input Meter) では演奏時の音量を表示します。 そこにはソフトウェア全体ののインプ
ットレベルをコントロールするボリュームフェーダーが備わっています。 ここでシグナルがクリッピングする
直前までシグナルレベルを上げてください。 このシグナル音量はレベルメーター(Level Meter)を見なが
ら、赤表示する手前の音量に調節します。
1本のギターを接続してある場合GUITAR RIG 4 は、モノシグナルを受信します。 インプットモジュールを
設定してこの信号を両方のチャンネルにルーティングすることも可能です。 デフォルトでは GUITAR RIG 4 
は両方のインプットチャンネル(L  + R が起動した状態)を使用するように設定されているので、インプットチ
ャンネルの片方がミュートした状態となります。 この設定を変更するには使用していないチャンネルを無効
にします。 インプットメーターの左にあるボタンのどちらかをクリックし(Lまたは R)これで使用しているイン
プットチャンネルのみが有効となります。 これで両方のチャンネルにモノシグナルを送ります。
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4.4.4	 アウトプットの接続
RIG KONTROL にはモニターシステムに接続する為の２つのモノアウトプットがあり(L/R) 、接続先はミキシ
ングデスク、または使用しているアクティブスピーカーとなります。 ステレオサウンドを聞くには、このアウトプ
ットの両方を接続する必要があります。 もう一つのステレオアウトプット端子(TRS) はヘッドフォン用です。

1.	 ボリュームを下げた状態で、アウトプットジャックをアンプのインプットに接続してください。
2.	 ヘッドフォンを使用する場合はアウトプットジャックに接続し、ヘッドフォンレベルが完全に下がった状

態で装着してください。
3.	 プリセットブラウザでプリセットの一つをクリックして選択してください。
4.	 演奏しながら慎重にアンプのボリューム、またはRIG KONTROL にあるヘッドフォンレベルを最適な

音量に調節してください。

ここまでの設定を完了したら、後は好きなように演奏するのみです。
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5	 Mac OS Xへのインストール
この章ではオーディオインターフェイスの設定の観点から、 Mac OS X に RIG KONTROL ハードウェア
をインストールする方法について解説します。  コントローラーとしてフットペダルを GUITAR RIG 4 で起
動する方法、関連したMIDI 機能の使用方法に関しては、本マニュアルのセクション6 を参照してください。
GUITAR RIG 4 ソフトウェアに関する詳細は、GUITAR RIG 4 マニュアルを参照してください。 マニュアル
は製品 CD、またはGUITAR RIG 4 メニューの Help > Open Manual > Japanese から閲覧可能です。

5.1	 ソフトウェアインストール
管理者権を使用してログインしてください。 この時点では、まだ RIG KONTROL を接続しないでください。
1.	 製品 CD の内容を閲覧し、そこで“Guitar Rig 4 Installer”を探してください。 ダウンロードしたバージ

ョンのGuitar Rig 4 を使用している場合は、インストールファイルを最初に解凍する必要があります。
2.	 インストールファイルをダブルクリックしてインストールを開始します。

	

3.	 スクリーン表示の手順に従ってインストールを行ってください。
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4.	 GUITAR RIG オーディオインターフェイス用ドライバのインストールを行う内容の質問が表示されます。 
“RIG KONTROL” を選択し、“Continue” をクリックしてください。

5.	 手順が完了したらコンピューターを再起動してください。

すると、以下のアプリケーションがハードドライブ上に設置されます。
•• GUITAR RIG 4 – 全機能を装備したスタンドアローンアプリケーションです。
•• GUITAR RIG 4 プラグイン – GUITAR RIG 4 を使用しているデジタルワークステーション(DAW)上

でプラグインとして使用可能です。 MAC OS X では VST、AU 、 RTAS® プラグイン形式を使用す
ることが可能です。

•• Native Instruments Service Center – このアプリケーションで製品の起動とアップデートを管理し
ます。 詳細についてはセットアップガイドを参照してください。

•• RIG KONTROL オーディオインターフェイス用ドライバです。

% NATIVE INSTRUMENTS 製品をこれまでに使用したことがない場合はスクリーンの指示に従ってレジスターす
る必要があります。 NI ユーザーアカウントの作成とGUITAR RIG 4 の起動の詳細に関しては、Service Center 

のインスタレーションフォルダーに付属しているService Center クイックスタートガイドとマニュアルを参照してください。

ハードウェアドライバのみをインストールする場合は、インストールCD のドライバ専用インストールファイル
を使用してください。 このファイルの最新バージョンはNative Instruments ウェッブサイトのサポートセ
クションから取得可能です。
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5.2	 ハードウェア インストール
付属のUSB ケーブルを使用し、 RIG KONTROL を使用しているコンピューターのUSB 2.0 ポートに接
続してください。

RIG KONTROL の電源供給源は USB です。 この機器を正常に作動するには単体のUSB 2.0 コントロー
ラー、または電源を供給するUSB 2.0 ハブの使用が必須です。
ドライバが正常にインストールされると、 RIG KONTROL が自動検知されます。 この時点でコンピュータ
が RIG KONTROL  を認識しない場合は、USB ケーブルをはずし、何秒か待った後再接続してください。 
それでも問題が解決しない場合は、インターフェイスを接続したままコンピュータを再起動してください。

5.3	 設定
この章ではGUITAR RIG 4 用に RIG KONTROL オーディオインターフェイスを Mac OS X  上で使用す
る方法を解説します。ここではサービスセンターを介して GUITAR RIG 4 の製品起動を行ったものとしま
す。製品起動に関してはセットアップガイドを参照してください。

5.3.1	 GUITAR RIG 4 の設定
それではGUITAR RIG 4 を設定し、RIG KONTROL オーディオインターフェイスを使用できる環境にしま
しょう。 この設定を行う前に、ソフトウェアを起動しておいてください。
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1.	 ソフトウェアを始めて起動する場合は、以下の設定を行うためのオーディオセットアップウインドウ
が自動的に表示されます。 後ほどこの設定を行う場合は、プログラムメニューから Guitar Rig 4 > 
Preferences と進んでください。

	

2.	  Audio タブで”ドライバ”インターフェイスとして CoreAudio を選択してください。
3.	 “Device”ドロップダウンメニューから、RIG KONTROL を選択してください。

GUITAR RIG KONTROL を接続している状態でもリストに表示されない場合は、何か問題があります。 セ
クション 5.1で解説したように、インストールをもう一度行ってください。
オーディオインターフェイスでは以下のパラメーターの設定が可能です。
•• サンプルレート(Sample Rate): 使用している音楽アプリケーションに対応したサンプル・レートを選択

してください。デフォルトでサンプルレートは44100 Hz (CDの音声品質と同等)に設定してあります。高
いサンプルレートで音質は向上しますが、CPUロードも高くなります。

••  レイテンシー(Latency): Latency スライダーを使用して、サンプル単位で表示されるオーディオインタ
ーフェイスのバッファサイズを設定します。 バッファサイズを高くすると、リアルタイム音声処理中に生じ
るオーディオドロップアウト率が低くなります。 バッファのサイズは使用しているシステムの全体的なレ
イテンシーに直接作用します。 バッファサイズを大きくすると、楽器を演奏してから音声が発音される
までの遅延が目立つようになります。
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まずはデフォルトバッファサイズを設定してインストールを完了することを推奨します。インストールが完了し
てから、プリセットをロードし、再度 Audio and MIDI Settings でシステムに最適なレイテンシーを設定し
てください。設定は、楽器を演奏しながらLatency スライダーを左へ徐々に動かし、バッファサイズを少しず
つ小さくすることで行います。音声のドロップアウト等が生じ始めたら、レイテンシースライダーを右へとドロッ
プアウト等のノイズがなくなるまで動かします。

5.3.2	 RIG KONTROL をデフォルトオーディオインターフェイスとして使用する
音声再生用に RIG KONTROL を使用するには、本機器をデフォルトオーディオインターフェイスとして設定
する必要があります。 Mac OS X では以下のように設定してください。
1.	 アップルメニューから、 System Preferences (システム環境設定)を選択します。
2.	 パネルが開くので、“Sound”をクリックします

	

3.	 サウンドエフェクト(Sound Effects)タブの、“警告とサウンドエフェクトの再生装置、Play alerts and 
sound effects through” メニューで、 RIG KONTROL を選択します

4.	 出力(Output)タブをクリックし、“サウンドを出力する装置の選択、Choose a device for sound out-
put” リストから RIG KONTROL を選択します。
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5.	 入力(Input)タブをクリックし、“サウンドを入力する装置の選択、Choose a device for sound input” 
リストから RIG KONTROL を選択します

5.4	 オーディオ接続とレベル
以下の章では、 RIG KONTROL にギターとモニターシステムを接続する方法を解説しており、またハードウ
ェア、ソフトウェア各での適切な音量設定についても解説しています。
この設定を行う前に、GUITAR RIG 4 を起動しておいてください。

5.4.1	 楽器の接続とインプットレベルの調整
1.	 モニターシステムのボリュームを最小にしてください。
2.	 プリアンプ等を使用して音声をブーストしている場合を除いて、インプットセレクターは“Instrument” (

ボタンを押していない状態) としてください。
3.	 ギター、またはベースからのケーブルを RIG KONTROL のインプットジャックソケットに差し込んでく

ださい。
4.	 インプットを使用しない場合、ボリュームを最小に絞っておきてください。

ステレオ音声を出力する機材(シンセサイザー等)を接続する場合は、各ステレオチャンネルに接続してくださ
い。
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インターフェイスを使用して十分な音量を維持しつつ音質を最適な状態に設定するには、 RIG KONTROL 
のインプットレベルを注意深く設定する必要があります。
インプットレベルメーターを確認しながら、最適なインプットレベルに調節してください。

LED 表示内容 意味

全 LED がオフの状態 入力シグナルが無い状態です。

LED が緑に点滅する状態 シグナルを入力しています。

LED が緑と赤に点滅する状態 入力シグナルが大きすぎます。

インプット感度を調節する前に、ギターのボリュームノブを上げてください。 通常演奏する音量でコードを
弾き、インプットレベルメーターを確認してください。
1.	 演奏しながらLED が赤表示するまで、選択したインプットジャックの隣にあるインプットレベルノブを

上げてください。
2.	 その後赤色点灯しなくなるまでノブを微妙に下げていきます。思い切りコードを弾いてもLEDが赤色点

灯しない位置まで慎重に調節してください。

これでインプット感度が最適な状態に設定となり、RIG KONTROL でクリッピングなく最大限のダイナミッ
クレンジ内で演奏することが可能です。

5.4.2	 2番目の楽器の接続
楽器同士の音量が殆ど同じ場合は、各インプットに異なる楽器を接続することも可能です。2番目の楽器をも
う一つのインプット端子に接続し、上記のようにインプットレベルを調節してください。
ステレオシグナルを生成する楽器を使用する場合は、両方のインプット端子をその楽器に使用することでス
テレオ音声を発生します。

% 単一のチャンネルのみを使用する場合は、一方のチャンネルゲイン(Gain )ノブをゼロにします。
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5.4.3	 GUITAR RIG 4 のインプットレベル
ここではギターを RIG KONTROL に接続しており、 インプットレベルが適切に設定されている前提で(セ
クション"4.4.1 楽器の接続とインプットレベルの調整" on page 22を参照)解説します。 ここからはソフトウ
ェア上でインプットシグナルを最適に設定します。
GUITAR RIG 4 ウインドウのヘッダ部分を確認してください。 そこにはチャンネルセレクター付きインプッ
トモジュール(L/R)、ノイズゲート、 リミッター付アウトプットモジュール、CPU 確認機能が備わっています。

インプットメーター(Input Meter) では演奏時の音量を表示します。 そこにはソフトウェア全体ののインプ
ットレベルをコントロールするボリュームフェーダーが備わっています。 ここでシグナルがクリッピングする
直前までシグナルレベルを上げてください。 このシグナル音量はレベルメーター(Level Meter)を見なが
ら、赤表示する手前の音量に調節します。
1本のギターを接続してある場合GUITAR RIG 4 は、モノシグナルを受信します。 インプットモジュールを
設定してこの信号を両方のチャンネルにルーティングすることも可能です。 デフォルトでは GUITAR RIG 4 
は両方のインプットチャンネル(L  + R が起動した状態)を使用するように設定されているので、インプットチ
ャンネルの片方がミュートした状態となります。 この設定を変更するには使用していないチャンネルを無効
にします。 インプットメーターの左にあるボタンのどちらかをクリックし(Lまたは R)これで使用しているイン
プットチャンネルのみが有効となります。 これで両方のチャンネルにモノシグナルを送ります。

5.4.4	 アウトプットの接続
RIG KONTROL にはモニターシステムに接続する為の２つのモノアウトプットがあり(L/R) 、接続先はミキシ
ングデスク、または使用しているアクティブスピーカーとなります。 ステレオサウンドを聞くには、このアウトプ
ットの両方を接続する必要があります。 もう一つのステレオアウトプット端子(TRS) はヘッドフォン用です。
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1.	 ボリュームを完全に下げた状態で、アウトプットジャックをアンプのインプットに接続してください。
2.	 ヘッドフォンを使用する場合はフォンアウトプットジャックに接続し、ヘッドフォンレベルが完全に下がっ

た状態で装着してください。
3.	 プリセットブラウザでプリセットの一つをクリックして選択してください。 演奏しながら慎重にアンプ

のボリューム、またはRIG KONTROL にあるヘッドフォンレベルを最適な音量に調節してください。

ここまでの設定を完了したら、後は好きなように演奏するのみです。
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6	 RIG KONTROL をコントロールインターフ
ェイスとして使用する

RIG KONTROL は GUITAR RIG 4 の使用に最適なハードウェアコントローラーとして機能します。 内蔵
コントロール機能の他に、MIDI 接続用端子と外部フットスイッチ用端子、外部ペダル用端子各が備わって
います。 以下のセクションでは、これらの機能をフル活用する為のハードウェアの設定方法を解説します。 
GUITAR RIG 4 をコントローラーインプットにアサインする方法に関しては、スタートアップガイドと、アプ
リケーションマニュアルを参照してください。 
RIG KONTROL を MIDI コントローラーとして使用するには、同封の CONTROLLER EDITORソフトウェ
アを使用してください。 詳細については コントローラーエディターマニュアルを参照してください。

6.1	 GUITAR RIG 4 で RIG KONTROL を起動する
RIG KONTROL はハードウェアを接続すると、自動的に GUITAR RIG 4 内で起動します。 初回起動の再
にウィンドウが表示され、ペダルのキャリブレーションを行うか尋ねます。 ペダルの稼動範囲全体を最初か
ら最後までなぞるように踏み込み、OK をクリックします。 キャリブレーションを再度行う場合は、オプショ
ン(Options) ページで環境設定(Preferences)を選択します。 RIG KONTROL Pedal Calibration の隣
にあるリセットボタンをクリックしてください。
RIG KONTROL ハードウェアには GUITAR RIG 4 内の視覚表示部(ラックの上の Virtual Kontrol をク
リックして表示)に対応する部分が備わっています。
GUITAR RIG 4 をホスト内等で複数起動している場合、どのインスタンスをフットペダルでコントロールす
るのか指定する必要がある場合があります。 デフォルトでは、最初に起動したGUITAR RIG 4　に対して 
RIG KONTROL が対応するよう設定してあります。 By clicking on the Connect button on the他の
インスタンスの Virtual Kontrol の Connect ボタンをクリックすることで RIG KONTROL が対応するよ
う切り替えることが可能です。一個以上のインスタンスをコントロールすることはできません。
いくつかの機能はデフォルトでフットスイッチの 5-8 にアサイン済みで、ハードウェアでそれらの機能を表示
しています。 ブラウザ内で確認可能なプリセットは 5 (PREV)と 6 (NEXT)のスイッチで切り替えることが
可能です。 スイッチ 7 と 8 はそれぞれチューナー、タップテンポ入力機能です。 これらのボタンはもちろ
ん自由に他の機能をアサインすることが可能です。
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簡単に RIG KONTROL のボタン、またはペダルに、機能をアサインするには Virtual Kontrol から各機能
のどれかをドラッグし、コントロールしたいパラメーター上でドロップします。 コントローラーアサインの詳細
については、スタートアップガイド、またはアプリケーションマニュアルを参照してください。

6.2	 RIG KONTROL MIDI と MIDI コントローラーの併用
MIDI メッセージを送信して他のアプリケーションをコントロールしながら、USB を介して RIG KONTROL 
と GUITAR RIG 4 がやり取りを続けることは可能です。 MIDI インターフェイスにはインプット/アウトプッ
トチャンネルが備わっています。
MIDI インプット端子に接続されたコントローラーを使用するには、 GUITAR RIG 4 内で RIG KONTROL 
MIDI チャンネルを起動しているか確認してください。
1.	  “Audio and MIDI Settings”を開いてください。 Windows では“File” メニューに、Mac OSでは 

Guitar Rig 4 メニューにあります。
2.	 MIDI タブを開きます。
3.	 Inputs テーブルでRIG KONTROL を指定し、 Status  をクリックして起動します。

MIDI インプットチャンネルは GUITAR RIG 4 のOptions ページで設定することができ、チャンネル設定は 
Preferences タブの“MIDI channel” ドロップダウンメニューをクリックし、1-16 チャンネル、またはomni 
を選択します。 外部 MIDI コントローラーへの機能のアサイン方法に関しては、スタートアップガイド、また
はアプリケーションマニュアルを参照してください。
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6.3	 追加フットスイッチとペダルの使用
RIG KONTROL には外部フットスイッチ/ペダル用端子を装備しています(¼” パッチケーブル使用) 。 接続
と設定がすめば、 GUITAR RIG 4 内のMIDI コントローラー同様アサイン可能となります。 スタートアッ
プガイドと、アプリケーションマニュアルを参照してください。
 GUITAR RIG 4 のOptions ページにある Preferences では以下の各設定選択肢があります。
•• 外部ペダルをキャリブレートするには、 RIG KONTROL Ext Pedals Calibration  の隣にあるリセッ

トボタンをクリックします。
•• 2列分のRIG KONTROL Ext Pedal 1/2 Mode で、各インプットで使用する外部フットスイッチ、また

はペダルを指定します。 ペダル、またはスイッチの仕様書を確認してから指定を行ってください。 設定
によって支障が生じる場合は、他のモードを試してください。
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7	 トラブルシューティング(Troubleshooting)
ハードウェアに問題がある場合は、テクニカルサポートに連絡を取る前に、以下の手順で問題解決方法があ
るか確認することを推奨します。
•• NI のオンライン知識ベース(Knowledgebase )をご覧ください。 GUITAR RIG 4 LE のメニューから

Help > Knowledgebase と進んでください。
•• 弊社ウェブサイト(http://www.native-instruments.com/forum/)のNIユーザーフォーラムを訪

れ、GUITAR RIGユーザーコミュニティーから適切な解決策を検索する。

テクニカルサポートチームに連絡を取る場合は、使用しているコンピューターの性能に関する情報も添えて
ください。ドライバのバージョン情報とファームウェアの情報については、ドライバコントロールパネルを確
認してください。
•• Windows コンピュータではスタートメニューの GUITAR RIG 4 LE アプリケーションフォルダーでド

ライバとファームウェアのバージョンを確認することができます。 各情報は“About”をクリックすると必
要な情報を確認することが可能です。

•• Mac OS Xコンピュータでは、システム環境設定からドライバコントロールパネルにアクセスします。メ
インウインドウに各情報が表示されます。

サポートチームに連絡を取るには、このURL を訪れてください。
http://www.native-instruments.com/support/
Native Instruments の全製品は開発の段階から実際の使用状況を想定して繰り返しテストを行っていま
す。 製品を返却する場合はテクニカルサポートチームがRA (Return Authorization、返品確認)をし、迅
速に対応します。 返却の際にはテクニカルサポートチームにご連絡ください。 このRAを記載しないまま製
品を返却すると、身元証明の妨げとなり、確認作業が確実に進行しない可能性があります。

7.1	 オーディオに関する問題解決法
このセクションではオーディオに関して頻出する問題に対応しています。

http://www.native-instruments.com/support/
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7.1.1	 音が出ない、音量が極端に低い。
音が出ない、または音量が小さい場合は幾つかの原因が含まれます。
•• ケーブルが破損している、または接続されていない。 すべての接続端子とケーブルを確認してくださ

い。
•• サウンドカード、またはオーディオインプットの選択が正しくない。 GUITAR RIG 4 メニューから“Audio 

and MIDI Settings”を選択し、 RIG KONTROL ドライバが選択されているか確認してください。
•• GUITAR RIG 4 のインプットモジュール内で異なるチャンネルを選択している。 楽器を他のインプッ

トジャックに接続するか、INPUT  モジュールの “L”を選択して他のチャンネルを指定してください。
•• RIG KONTROL のインプットゲインの設定値が低すぎる。 対応するインプットレベルを上げてくださ

い。
•• 使用している楽器の音量を上げていない。 ボリュームノブを調節してください。

7.1.2	 音声が歪む
GUITAR RIG 4 ソフトウェアのディストーションエフェクトを使用していないのにオーディオシグナルが歪ん
でいる場合は、殆どの場合 RIG KONTROL のゲインが高く設定され過ぎていることに起因します。 インタ
ーフェイスのインプットレベルを下げプリアンプのクリッピングを回避してください。 楽器自体の音量が大き
くプリアンプが常時オーバードライブする場合は使用している楽器の音量を下げてください。 通常この現象
は、使用している楽器に高パワーピックアップが備わっている場合に起こります。

7.1.3	 ノイズ
ハムノイズが起きる原因は様々です。以下はノイズ発生例です。
•• シングルコイルピックアップは電気的干渉を集めやすい特性を持っています。ハムバッカー(Humbucker)

ピックアップは名前が示すとおり、ハムノイズ発生量が比較的少ないです。
•• 使っているギターが電気機器に近すぎる。この種のハムノイズを減少させるには、ノイズ発生の原因と

なっている機器からギターを遠ざけてください。
•• ギターのボリュームノブ音量が小さく設定されている。ノブを上げてください。使用しているギターが一

つ以上のノブを備えている場合は各ノブを確認してください。
•• ケーブルが破損している。ギターシールドが適切ではない場合もあります。シールド加工してあるケーブ

ルと交換してください。改善されない場合は専門家に相談してギター自体を修理してください。
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ヒスノイズが生じる場合は、 RIG KONTROL のインプットレベルが極端に低くないか確認してください。 
楽器の音声または、 RIG KONTROL のインプットレベルを上げてください。 インプットレベルの設定に
ついては、本マニュアルのセクション4.4(Windows XP/Windows Vista) またはセクション5.4 (Mac OS 
X)を参照してください。

7.1.4	 グラウンドループ
グランドループ(ハム、またはバズノイズ)は複数の電気機器を同一電源に接続した場合に起きる一般的な問
題です。これらのノイズを回避するには以下の手順を実行してください。
•• 使用していない機器の接続を全て外して下さい。例)コンピュータに接続している周辺機器 (外付けデー

タ保存機器、CD バーナー等)。
••  RIG KONTROLアウトプット以降にDIボックスを備え付ける。 殆どのボックスはグランドリフトスイッ

チを備えており、ループに干渉してノイズを取り払います。

7.2	 ハードウェアに関する問題
RIG KONTROL ドライバアップデートとその他の情報に関しては、Native InstrumentsウェブサイトとNI
サービスセンターで確認してください。

7.2.1	 ドライバの問題
RIG KONTROL  がコンピューターに接続してあるのを確認してからコントロールパネルを開きます。 この
章の導入部を確認し、コントロールパネルを確認してください。
コントロールパネルがない場合は、ドライバがインストールされていない可能性が高いです。この場合は、本
マニュアルに従って、ドライバを再度インストールしてください。
コントロールパネルのメニューが全て灰色表示されている場合は、 RIG KONTROL  がドライバに認知さ
れていないことを示します。 この場合、USB 接続に問題がありますので、以下セクションで確認を行ってく
ださい。
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7.2.2	 USBの問題
RIG KONTROL はUSB 2.0 のインターフェイスで、USB 1.0/1.1 端子では動作しません。 常に直接コン
ピュータのUSB 2.0 端子に接続してください。 このUSB 2.0 ポートは最小電力を(500 mA)を必要としま
す。 コンピューターによってはUSB 2.0 の使用必要条件を満たさないのでUSB 2.0 を使用することが出
来ません。 この場合、機器を有効に作動させるための電力が無いという趣旨のメッセージが現れます。 こ
のまま RIG KONTROL  を使用すると、雑音が生じる、または完全に作動しない場合もあります。
•• 使用しているコンピュータが十分なバス電源を供給しない場合は、 RIG KONTROL を外部電源供給

機能付USB 2.0 ハブに接続してください。 全ての機器の電源量総量が減少する原因となるので、ハブ
にその他のパワードバスハブを接続しないで下さい。

•• 以上を行っても問題が改善されない場合は、RIG KONTROL  以外の全てのUSB 機器の接続をはず
して動作確認を行ってください。

•• オーディオドロップアウトが生じる、またはUSBに関連するその他の問題が生じる場合は、RIG 
KONTROL を他のUSB 2.0ポートに接続してください。

•• 古くなったUSBケーブルがオーディオドロップアウトの原因となったりその他の問題の起因となっている
場合もあります。正式なUSBロゴ表示のあるケーブルを使用してください。短いケーブルが有効な場合
もあります。

•• RIG KONTROL がウインドウズ上で頻繁にクラッシュしたり正確に動作しない場合、デフォルトではオ
ンになっているUSB ハブの電源マネージメントをオフにする方法があります。 デバイス・マネージャへ
行き(Control Panel > System > Hardware)、USBハブを右クリックして、プロパティを開いてくださ
い。 パワーマネージメントページでこのチェックボックスのチェックを解除します。 これを各ハブにつ
いて繰り返し、再起動してください。

7.2.3	 ラップトップで RIG KONTROL を使用する
始めに使用しているコンピューターがオーディオドロップアウトなく、リアルタイムオーディオ処理に適してい
るか確認してください。以下のフリーウェアでシステムを分析し、確認することが可能です。
www.thesycon.de/deu/latency_check.shtml
RIG KONTROL が接続されていない状態で、この確認ツールを起動してください。 コンピューターがオーデ
ィオ処理に対応していない場合は、レイテンシーバーが赤く表示され、下のボックスにリポートを表示します。
一般的に共有メモリグラフィックカードをラップトップに使用することは推奨されていません。オーディオ処
理を円滑に行うにはメモリと的確な処理精度が必要です。

http://www.thesycon.de/deu/latency_check.shtml
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ラップトップをライブ用に使用するには、以下の点を確認してください。
•• ラップトップをバッテリーのみで使用すると、パワーマネージメントシステムがバッテリーを節約し、CPU 

のクロックレートを遅くすることがあるので、バッテリーのみの使用は推奨しません。
•• 演奏中に使用しない機器は外して下さい。(例、プリンター、スキャナー等)。これによって音楽ソフトに対

する処理能力が向上します。
•• ラップトップにはオーディオ処理を妨げるネットワークアダプターや、ワイヤレスLANカード等の内蔵デ

バイスが装備されていることが多々あります。 これらの機器も RIG KONTROL を使用している時は、
無効にしておく必要があります。
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8	 技術仕様書
このセクションでは RIG KONTROL ハードウェアに関する技術的仕様を記載しています。

8.1	 ジャックとソケット
•• 2 input jacks (In 1, In 2) for mono 6.3mm (1/4 inch) phone plugs
•• 2 output jacks (Out 1, Out 2) for 6.3mm (1/4 inch) mono (unbalanced) or TRS (balanced) 

phone plugs
•• 1 Headphones jack for stereo 6.3mm (1/4 inch) phone plug
•• 2 input jacks for external pedals / footswitches / switchboxes
•• (Pedal 1, Pedal 2) for stereo 6.3mm (1/4 inch) phone plugs
•• 2 MIDI (In/Out) 5-pin DIN circular connector
•• 1 USB 2.0 Type B
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8.2	 オーディオ仕様

オーディオインプット (A/D)

チャンネル 2

サンプルレート 44.1, 48, 88.2, 96, 192 kHz

ビット解析度 16, 24 Bit

Converterコンバーター Cirrus Logic

インストゥルメントインプット

インプットインピーダンス 1 MΩ

フルスケールレベル(最大ゲイン時) -11.5 dBu

最大インプットレベル +16 dBu

SNR (weighted) > 100 dB

THD+N 0.009%

周波数特性 +/- 0.5 dB 20 Hz – 24 kHz

ダイナミックレンジ 105 dB (ADC)
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ラインインプット

インプットインピーダンス 44 kΩ

フルスケールレベル(最大ゲイン時) -5.5 dBu

最大インプットレベル +16 dBu

SNR (weighted) > 100 dB

THD+N 0.009%

周波数特性 +/- 0.5 dB 20 Hz – 36 kHz 

ダイナミックレンジ 105 dB (ADC)

オーディオアウトプット (D/A)

チャンネル 2

サンプルレート 44.1, 48, 88.2, 96, 192 kHz

ビット解析度 16, 24 Bit

Converterコンバーター Cirrus Logic
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ラインアウトプット

アウトプットインピーダンス 100 ohms

最大アウトプットレベル +6.3 dBu

SNR (weighted) > 100 dB

THD+N 0.010%

周波数特性 +/- 0.5 dB 22 Hz – 44 kHz

High/low レベルスイッチ Full scale 5Vpp / -14dB

ヘッドフォンアウトプット

負荷インピーダンス 8-600 ohms

最大アウトプットレベル 1.61 V RMS @ 100 ohms

SNR (weighted) > 91 dB

THD+N (60 ohms) 0.013%

周波数特性 +/- 0,5 dB 22 Hz – 44 kHz
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8.3	 電源
USB 2.0 インターフェイス使用、5V 500mA バスパワー
USBパワーを使用するのみで追加電源やバッテリーを必要としません。 しかしながら RIG KONTROL 単
体のみをUSB 2 コントローラー、またはパワードUSB 2 ハブを介して使用する場合の正常動作を保障す
るものとします。 

8.4	 寸法と重量
寸法: 360 x 237 x 102 mm (14.17 x 9.33 x 4.02 in)
重量: 2.6 kg (5.73 lb)

8.5	 環境仕様
作業可能気温: 0°C から 40°C /32°F から104°F (85% 凝縮湿度ではない通常湿度)
保管気温: -20°Cから50°C /-4°F to 122°F  (85%凝縮湿度ではない通常湿度)

8.6	 動作環境

8.6.1	 一般システム仕様
Windows XP (Service Pack 2 版)またはWindows Vista (32/64 bit)、 Intel® Pentium™ 、AMD® 
Athlon™ XP 1.4 GHz、 1024MB RAM、 USB 2.0
Mac OS 10.5、 Intel® Core™ Duo 1.66 GHz、 1024 MB RAM、USB 2.0
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8.6.2	 サポートドライバ形式
Mac OS: Core Audio™
Windows: ASIO® (recommended)、 DirectSound™、 WASAPI™

8.6.3	 サポートプラットフォーム
Mac OS: スタンドアローン、 VST®, Audio Units™, RTAS® (Pro Tools 7/8)
Windows: スタンドアローン、 VST®, RTAS® (Pro Tools 7/8)


	1	GUITAR RIG 4 の世界へようこそ!
	2	ご使用の前に – 注意事項
	2.1	シリアルナンバー& ネームプレート
	2.2	安全に使用するために
	2.2.1	注意事項
	2.2.2	危険事項
	2.2.3	廃棄処分時の注意点

	2.3	免責事項

	3	RIG KONTROL ハードウェア
	3.1	トップパネル
	3.2	リア・パネル

	4	Windows XP/Windows Vistaへのインストール
	4.1	ソフトウェアインストール
	4.2	ハードウェア インストール
	4.3	設定
	4.3.1	GUITAR RIG 4 の設定
	4.3.2	RIG KONTROL をデフォルトオーディオインターフェイスとして使用する

	4.4	オーディオ接続とレベル
	4.4.1	楽器の接続とインプットレベルの調整
	4.4.2	2番目の楽器の接続
	4.4.3	GUITAR RIG 4 のインプットレベル
	4.4.4	アウトプットの接続


	5	Mac OS Xへのインストール
	5.1	ソフトウェアインストール
	5.2	ハードウェア インストール
	5.3	設定
	5.3.1	GUITAR RIG 4 の設定
	5.3.2	RIG KONTROL をデフォルトオーディオインターフェイスとして使用する

	5.4	オーディオ接続とレベル
	5.4.1	楽器の接続とインプットレベルの調整
	5.4.2	2番目の楽器の接続
	5.4.3	GUITAR RIG 4 のインプットレベル
	5.4.4	アウトプットの接続


	6	RIG KONTROL をコントロールインターフェイスとして使用する
	6.1	GUITAR RIG 4 で RIG KONTROL を起動する
	6.2	RIG KONTROL MIDI と MIDI コントローラーの併用
	6.3	追加フットスイッチとペダルの使用

	7	トラブルシューティング(Troubleshooting)
	7.1	オーディオに関する問題解決法
	7.1.1	音が出ない、音量が極端に低い。
	7.1.2	音声が歪む
	7.1.3	ノイズ
	7.1.4	グラウンドループ

	7.2	ハードウェアに関する問題
	7.2.1	ドライバの問題
	7.2.2	USBの問題
	7.2.3	ラップトップで RIG KONTROL を使用する


	8	技術仕様書
	8.1	ジャックとソケット
	8.2	オーディオ仕様
	8.3	電源
	8.4	寸法と重量
	8.5	環境仕様
	8.6	動作環境
	8.6.1	一般システム仕様
	8.6.2	サポートドライバ形式
	8.6.3	サポートプラットフォーム



